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1 Introducing Rapture3D
Thanks for using Rapture3D! Rapture3D gives a full 3D surround sound experience through
sophisticated use of Higher Order Ambisonics. This edition can handle small or large numbers of
speakers, or headphones. Rapture3D can produce:

3D audio for use in the studio• 
3D audio for gaming• 
3D audio playback of ambisonic sound files• 

This is help for the "Advanced" edition of the software. There are "Game" and "User" editions too,
and a "Universal" edition for cross-platform game development. The "Advanced" edition is special
because it does the maths to allow you to set up custom speaker layouts and import personalised
HRTFs. A range of preset are also available too, with a large number of configuration options.

The Advanced Speaker Layout software should be used to configure your speakers before
Rapture3D is used in any of its forms.

1.1 The Rapture3D Decoder Studio Plugins

For work in the studio, the Rapture3D advanced decoder can be used as AAX or VST2 plugins
within certain Digital Audio Workstations (DAWs) such as Reaper, Pro Tools or Max/MSP. They are
not compatible with all DAWs because many cannot provide sufficiently wide busses.

1.2 The Rapture3D OpenAL Driver

For some games, the Rapture3D OpenAL driver can be used in place of the system OpenAL driver
to take advantage of Rapture3D's sophisticated 3D audio rendering.

1.3 The Rapture3D Ambisonic Player

Rapture3D comes with a player for ambisonic sound files (typically .AMB files). Unlike standard
"surround" mixes, these can reproduce full 3D audio.
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2 Sound Card Set Up
Before doing anything else, you might want to take a moment to check that your audio hardware is
set up correctly to work with Rapture3D.

In this advanced edition of Rapture3D, you can route channels of audio to specific audio outputs
from your computer to set up non-standard or specially configured speaker layouts. This normally
takes more time than with the automatic "Game" or "User" editions of Rapture3D, but is much more
flexible.

Note that the AAX and VST2 plugins do not use these soundcard settings. This is because the
plugins are hosted within another program (such as Pro Tools or Reaper) and it is that host program
that will access the audio hardware and will need to be configured. However, when dealing with
multichannel systems we strongly suggest using identical channel ordering in different
configuration screens to avoid confusion or complicated rewiring later.

2.1 Audio On Windows

On Windows, the Rapture3D OpenAL driver and Rapture3D Ambisonic Player support audio output
either through DirectSound or Steinberg ASIO.

2.1.1 Windows DirectSound

DirectSound-compatible sound cards are the normal type for Windows, so if other sounds are
working then Rapture3D probably will too. If you want to use Rapture3D this way, you'll need to
make sure Windows is configured properly so that Rapture3D can find out about all the speakers
you want to use.

If you don't have a speaker layout fully set up, Rapture3D will normally try to default to sensible
settings that match DirectSound. But this rather misses the point of this edition of the software!
You'll probably want to use the Advanced Speaker Layout tool to tune things further so the sound is
just as you'd like it.

2.1.1.1 Windows DirectSound Advanced Sound Card Set Up

For fine-grained configuration, Windows "Control Panel" is normally available from your Windows
"Start" menu. Within this, depending on how you have it set up and your operating system, you will
see a section with a names like "Sound", "Sounds, Speech, and Audio Devices" "Sounds and Audio
Devices" or "Hardware and Sound".

When this is selected, you should see something like one of these:
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If you click through the tabs, you should see the audio settings you're using for other audio
playback. If they don't look right, they will probably need to be reconfigured before you proceed.

Once you're done, click on the "Configure..." button if it's enabled (or "Advanced..." on older
versions of Windows). This should bring up another window as below. If it doesn't, or if the button
isn't enabled, it's probably just that your sound card is stereo only.

The important thing here is the "Audio channels" setting, or the "Speaker setup" choice on older
versions of Windows. This should normally be set as close as possible to the actual layout of the
speakers you're using.

Make sure that the layout you select shows all the channels you're going to want to use in the
Speaker Layout Tool, even if they're not in the right places in the picture (you can always set up the
routing and locations correctly in the layout tab). For instance, if your computer sound card has
eight suitable outputs and you want to use a cube layout, you might be able to set DirectSound to
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7.1 mode (which uses eight channels) and then set the correct routing (e.g. what DirectSound thinks
is "Front Left" could be routed to "Lower Front Left" and so on). If you set Windows to only use
stereo, then the only outputs you'll have to choose from on the layout tab will be "Left" and "Right",
regardless of how many actual outputs there are on the back of your computer!

A word or warning: in principle 5.1 or 7.1 layouts include a subwoofer channel, so the cube set up
described above is abusing this channel. In practice all of the soundcards we've seen route this
straight out without doing anything "clever", but you might find sound cards or (more likely) your AV
receiver trying to do bass management or other special processing with this channel. If you can't
disable this, you'll need to work around this limitation when you set up your layout and resign
yourself to using the subwoofer channel as a subwoofer.

Click on "OK" when you've finished making changes, or "Cancel" if you want to leave things as they
were.

2.1.2 Steinberg ASIO

Most studio-grade audio hardware supports supports Steinberg ASIO. This is often the best way to
access large numbers of channels, high audio fidelity and low latency processing.

If you have ASIO audio hardware then it may well come with its own configuration tool. You
probably should check everything is set up correctly there and that your drivers are up to date
before launching the Speaker Layout tool. After this, making an ASIO sound card work with
Rapture3D should be straightforward, although normally each channel will need to be "wired"
individually.

Your ASIO device should appear in the Audio Device section of the Layout tab when "Steinberg
ASIO" is selected.

Some ASIO sound cards allow buffer sizes to be configured. 256 or 512 are sensible settings for
gaming, although lower settings allow lower latency operation for studio use.

2.2 Audio On macOS

On macOS, audio is accessed through Core Audio and audio hardware will appear as normal. Your
audio devices should appear in the Audio Device section of the Layout tab.

As always, please check your drivers are up to date!
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3 Advanced Speaker Layout
Rapture3D itself is set up using the Advanced Speaker Layout tool. Normally, this appears under
"Blue Ripple Sound" on the "Start" menu on Windows, or in a "Blue Ripple Sound" folder in your
Applications area on macOS.

Set up is done in stages, each with its own tab:

On the Layout tab, check your sound card has been set up correctly and that the speaker (or
headphone) layout is correct. You can also set up special speaker layouts and select
non-standard audio outputs.

1. 

The Decoder tab can be used to select the decoder that will be used for the layout chosen
on the previous tab.

2. 

On the Rapture3D tab, you can choose the settings that will be used when a game is
running.

3. 

On the Ambisonic Playback tab, you can choose the settings that will be used when
ambisonic playback is in use.

4. 

Normally license set-up happens automatically, but if it didn't or if you want to move a license to
another machine, you can use the Licenses tab to manage your Blue Ripple Sound licenses.

There's also a Logs tab that you might want to look at if you're troubleshooting.

Click on "Apply" or "OK" when you're happy with your changes, or "Cancel" if you want to leave
things as they were. Note that if there is a game running when you do this, Rapture3D will attempt
to restart itself, so make sure you save your place first as some games may not like this.

The About tab has information about us (Blue Ripple Sound), the edition of the software you're
using and other third-party software we've used, plus some legal stuff. Please read!
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3.1 How Are You Getting On?

A message may appear in red at the bottom left of the screen indicating any issues with the current
set up. These messages are intended to help guide you through the set up process.

Rapture3D won't work properly until such issues are resolved - if you try to use it in the meantime, it
may attempt to recover so you may get some sound, though possibly not exactly what you wanted.
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3.2  The Layout Tab

This is where most of the "action" happens with the advanced edition of the software. It's worth
spending a few minutes to understand what's going on here.

This tab lets you tell Rapture3D how your speakers are set up, so that it can work out how to feed
sound to them to produce the best spatial imaging. If you use a customised layout you will need to
"compute a decoder" on the next tab after you have finished here.

On Windows, if you are familiar with the "Game" or "User" editions of the software we should
probably warn you that this edition does not automatically synchronize with your Windows settings.
Everything is under manual control, so if you want to use a DirectSound sound card then you need
to make sure everything  is set correctly in Windows Control Panel yourself before starting up the
Advanced Speaker Layout program.

Preset speaker layouts with decoders are provided. However, even if you are using a standard
multichannel layout for which there is a preset (such as 5.1) we generally recommend that you
customise the layout using this tab rather than using the preset directly. In particular, it is good to tell
Rapture3D the speaker distances that are in use (disable "Only use location directions" and change
the "R" location settings) and correct the azimuths if they are not exact (and elevations if you are
using a 3D layout).
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3.2.1 Preset Layouts

This edition of Rapture3D comes with support for the following preset layouts. For most of them, it's
probably easiest just to select them and look at the image to see where the speakers are expected.

Format Description
Stereo This is a straightforward layout using two speakers.

Headphone Stereo This is what should be selected if you're using a set of headphones.
Mono Just one speaker is available.
Quad Four speakers at the corners of a square.

Surround 5.0/5.1

5.0 is an arrangement with front left, right and centre speakers and two
"surround" speakers at the side or back. 5.1 adds a subwoofer, which can
go anywhere in the room. These layouts assumes that the four corner
speakers are set out roughly in a square, which is slightly different to the
"standard" ITU layout below. We find that many gamers and sound
positioning systems use this.

Surround 5.0/5.1 (ITU)

These are versions of the "Surround 5.0" or "Surround 5.1" layouts that
you may well have set up if you're following cinema conventions rather
than gaming ones. These layouts have larger gaps between speakers to
the side and rear, as recommended by the ITU (International
Telecommunication Union). Specifically, your front left and right speakers
are expected to be 30 degrees from front centre and the "side" speakers at
110 degrees. Try changing the Layout drop-down between the options and
see which one looks most like the actual layout you're using. Don't worry
about the location of the large "subwoofer" in the picture - this can go
anywhere in the room.

Surround 5.1.2
This is an eight-channel layout formed from a 5.1 layout with two additional
ceiling speakers, to the left and right above the listener. The corner
speakers of the 5.1 are assumed to be set out roughly in a square.

Surround 5.1.2 (ITU)
This is an eight-channel layout formed from a 5.1 ITU layout with two
additional ceiling speakers, to the left and right above the listener. The
corner speakers of the 5.1 are assumed to be at standard ITU angles.

Surround 6.0/6.1 These layouts are similar to "Surround 5.0 (ITU)" and "Surround 5.1 (ITU)",
adding a central rear speaker.

Surround 7.0/7.1 This adds two more speakers to "Surround 5.0 (ITU)" and "Surround 5.1
(ITU)", so there are two side and two back speakers.

Surround 7.1 (Wide)
This is a widescreen speaker layout used in some cinemas, where
placement of sounds across the screen for many viewers is prioritised over
immersion and front/rear balance.

Surround 3D7.1
This layout takes a bit of effort to set up, but is well worth the effort as it
allows sounds to be placed above and below! (It works fine for stereo and
5.1 films too.)

Surround 7.1.2 (Dolby
Atmos)

This format is similar to "Surround 7.1" with two additional ceiling
speakers, to the left and right above the listener. This is a common bed
format in Dolby Atmos.

Surround 7.1.4 This format is similar to "Surround 7.1", adding four "Top" speakers in a
square above the listener.
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Format Description

Surround Stereo

It's possible you have your computer set up using stereo (i.e. two
channels) but you're feeding the audio to another box with a "surround
decoder" which will do some clever stuff and then feed to more than two
speakers. "Dolby Pro Logic" is an example of this. If you select this
option in Rapture3D we'll try to generate a compatible signal (make sure
you select the right "Method" on the "Decoder" tab though). These
systems typically don't work as well as feeding the surround speakers
directly, but they aren't bad.

Auro-3D (9.1, 10.1, 11.1
and 13.1)

These are Auro-3D speaker layouts, using 10, 11, 12 or 14 channels.
They are 3D layouts using a set of raised speakers above the normal
channels of ITU 5.1. Auro-3D 9.1 adds raised speakers above the 5.1
corner speakers. Auro 10.1 adds a further speaker directly above the
centre of the room, Auro 11.1 adds a raised front centre speaker and
Auro 13.1 adds the back speakers from normal ITU 7.1.

IMAX (5.0, 6.0 and 12.0) These layouts are used in IMAX theatre systems.

Surround 10.2

This is a 12 channel layout developed by Tomlinson Holman for cinema
use, using seven front channels including two raised channels, three
surround channels and two subwoofers. This is not the same as the 10.2
layout used in Steinberg Nuendo, which is closer to Auro-3D 10.1.

Hamasaki 22.2 This is a 24 channel layout used in the Ultra High Definition Television
standard.

Circle (16/32) These are arrangements of 16 or 32 speakers in a horizontal circle.

Cube
This is an arrangement of eight speakers at the corners of a cube. This
can produce good vertical images, although gaps can appear in the
middle of the faces.

Twisted Cube
This is an arrangement of eight speakers at the corners of a cube, but
with the upper layer rotated by 45 degrees. This rotation improves
coverage on the horizontal plane.

Dodecahedron This is an arrangement of twenty speakers at the corners of a
dodecahedron.

Hexagon 1/2 These are arrangements of six speakers in a horizontal circle. There are
two versions, shifted by a 30 degree rotation.

Icosahedron An arrangement of twelve speakers at the corners of an icosahedron.

Octagon 1/2 These are arrangements of eight speakers in a horizontal circle. There
are two versions, shifted by a 22.5 degree rotation.

Octahedron

This places the speakers on the corners of a regular octahedron
("bi-triangle") arranged so the front and back planes are vertical. This is
actually the same as the Surround 3D7.1 layout without the subwoofer
and Front Centre speakers.

Compatibility
("Compat.") Modes

These modes appear on Windows only and are actually the same as
other layouts with similar names. They can simply be ignored for most
purposes (they're used by the "User" and "Game" editions of the
software).

Only some settings can be changed for preset layouts. If you need to change more (for instance if
you want to change the location of one speaker) then you should create a new layout based on the
existing one.

3.2.2 Creating New Layouts

To create a new layout, select "New..." from the Layout drop-down and choose a name for your new
layout. You might prefer to start out with a copy of an existing layout - just use the "Base On

Copyright 2023 Blue Ripple Sound Limited 9



Existing Layout" drop-down from the window that comes up. Or you can start out with no speakers
and add them one by one, or import them.

Alternatively, you can just select the layout you want to base your new one on and click the
"Customise..." button.

A quick introduction to designing good speaker layouts is available.

3.2.3 Import and Export

Press these buttons to import or export layout information. Generally we recommend use of .SLF
files as this loads or saves the complete description of the layout, including audio output
configuration and overall and individual speaker volumes.

3.2.4 Delete Layout

Press this button to delete a layout that you have created. This should not be used for preset
layouts.

3.2.5  Audio Device

This comes in two parts. The left-hand part selects what software audio framework is in use and the
right-hand part selects the actual audio device within that framework.

On Windows, two frameworks are supported:

Microsoft DirectSound - this allows access to "standard" Windows sound cards.• 
Steinberg ASIO - this allows access to low-latency studio kit.• 

On macOS, the Core Audio framework is supported.

The devices listed will depend on the actual sound cards (or other audio hardware) attached to your
computer.

When you select something here, the channels will be connected up automatically to the channels
available, assuming there are enough of them. This wiring may well be wrong though, so you should
check and test the individual Audio Outputs.

3.2.6 Overall Volume

This gain control is applied in combination with volume controls in other places. It should be used to
get the speaker levels in roughly the right place for comfortable listening. Other volume controls can
be used for fine control. Note that changes to these volume controls are not made until "OK" or
"Apply" are pressed.
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Having said that, please set it really low before testing out any of your channels so you don't blow
any speakers or damage your ears. We're assuming you're being sensible with external
amplification here - please be careful to make sure your whole signal chain won't damage any kit or
ears.

Please please please test the levels on this tab before starting up anything else. If you start a game
with volumes set to high levels (e.g. because you've wired straight to active speakers - yes, we've
done this and are speaking from experience) then you can end up reaching for your mains power
switch to make the deafening noise stop quickly enough.

3.2.7  Distance Mode

This won't be editable if you're using a preset layout. Create a new layout based on the current one
if you want to modify it.

This control indicates whether or not you're providing accurate information about how far away the
speakers are from the centre (the base of the green arrow in the picture). If "Only use location
directions" is selected, then the software will pretend that all the speakers are the same distance
away and that the exact distance isn't actually known. This reduces the quality of the soundfield
reconstruction.

The distance compensation takes into account the fact that sound from distant speakers will arrive
at the centre later than sound from closer speakers.

Also, more distant speakers will typically be driven at higher levels than closer ones. For these
purposes, the reference distance is 1m, and a speaker at a distance of r metres will typically be
driven with a gain (in decibels) roughly 20log10(r) louder that it would at the reference distance
(this is roughly 6dB for each doubling of distance). If you are concerned about clipping, or volume
levels close to the speakers, you may wish to compensate for this using the Overall Volume control
above.

Enabling the "Only use location directions" switch is sensible if you don't have accurate
measurements and your speakers are roughly the same distance away from the centre. You'll see
the graphics update to show how this makes the layout look.

3.2.8 Audience Face

This tells Rapture3D the directions that audience members face while listening. It affects the
psychoacoustic cues used during tinted decoding. Options are:

Forward - audience members are assumed to be upright or seated, and facing forwards
along the X axis. This is usual for computer games and film.

• 

Forward/Upright - this is a blend between Forward and Upright modes.• 
Upright - audience members are assumed to be upright. This is usual in a space where
people can walk around freely, sit or stand.

• 

Free - here no assumptions are made about how the audience members are oriented. This
is somewhat unusual.

• 

3.2.9 Bass Crossover

When at least one speaker is a sub-woofer with role "Bass (Managed)" (see below), Rapture3D
uses bass management for all but "Basic" decoders.

When bass management is in use, a crossover filter can be used to route low frequencies to the
bass-managed sub-woofers and to remove them from other decoder channels. The selected bass
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crossover is the middle frequency of this filter, measured in Hertz. If your speakers have crossovers
build in, make sure they are all set the same and select "External" from the drop down menu, which
disables the Rapture3D crossovers. Using crossovers in both Rapture3D and your speakers is not
recommended as it is likely to result in a loss of sound energy around the crossover frequencies.

If you have more than one bass-managed sub-woofer, Rapture3D may generate a bass decoder for
low frequency spatialisation, using soundfield reconstruction. Typically, four or more sub-woofers
are required. Otherwise, a mono bass signal is used and bass is not spatialised.

To check if bass spatialisation is in use, see the "Bass Soundfield Reconstruction Decoders" section
of the report when computing decoders. You may wish to check this before finalising your speaker
layout.

3.2.10 Channel

Use this to select the channel to be edited within the "Channel Settings" region below.

The buttons to the side can be used to add or delete channels, or move individual channels up and
down.

3.2.11 Channel Settings

This region shows the settings for the speaker selected in the "Channel" control above. The
corresponding speaker is indicated in white in the image.

3.2.11.1 Name

This won't be editable if you're using a preset layout.

This is the name of the channel.

3.2.11.2 Location

This won't be editable if you're using a preset layout.

This is the location of the speaker, expressed in Cartesian and Polar coordinates relative to an
origin shown in the graph at the base of the green arrow, in metres.

The coordinate system is arranged as follows:

Positive X Forwards
Negative X Backwards
Positive Y Left
Negative Y Right
Positive Z Up
Negative Z Down

Azimuth ("A") is measured anticlockwise (left) from the front and elevation ("E") is measured
upwards from the horizontal. Radius ("R") is measured outwards from the origin, in metres.

Note that if you've enabled "Only use location directions", then the actual graphics drawn will always
crush or stretch the actual speaker location drawn so it's the same distance from the origin. This can
be quite confusing so you might want to switch it off while tweaking locations.
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When "Only use location directions" is not enabled then measurements are in metres. This does
actually matter as the internal calculations use the speed of sound.

3.2.11.3 Speaker Type

This won't be editable if you're using a preset layout.

Use this to indicate each speaker's type. Generally these should all be set to "Normal" except for a
"Sub-Woofer" if one is present. However, if you have a number of additional tweeters you may wish
to indicate these using the "Small" option.

Note that if you select a subwoofer, you'll need to set the speaker role to either "Bass (Managed)" or
"Bass (LFE Only)" so the decoder generator knows whether it should do its own bass management
or leave it to your AV receiver.

3.2.11.4 Speaker Role

This won't be editable if you're using a preset layout.

Normally speakers are "General" speakers, which means they are used for general sound
spatialisation. However, some special speakers have other roles in addition to (or instead of) this.
For instance, some games send dialogue directly to a "Front Centre" (or "Front Centre (Dialogue
Only)") speaker if one is present, bypassing the general sound spatialisation engine.

The following roles have special behaviour:

Inactive - this excludes the speaker from use in decoders.• 
Front Centre (Dialogue Only) - if this is selected, then the speaker will be excluded from the
decoder when it is generated on the Decoder tab. This is useful where the front centre
speaker is actually a different kind of speaker designed specifically for dialogue. Rapture3D
supports an extension that allows dialogue from the game to be fed to the speaker even
though it is not used for the main 3D audio stream.

• 

Bass (LFE Only) - if this is selected for a subwoofer, then the speaker will be excluded from
the decoder when it is generated on the Decoder tab. This is useful in the normal case
where the output from Rapture3D is going to be fed to an external AV receiver or other piece
of audio kit which is going to perform bass management - in this case, the external device
will make sure an appropriate level of bass ends up in the speaker. Further, Rapture3D
supports an extension that allows bass low frequency effects from the game to be fed to the
speaker even though it is not used for the main 3D audio stream.

• 

Bass (Managed) - if this is selected for a subwoofer, then Rapture3D will perform bass
management and generate an audio stream containing only low frequencies for this
speaker. Do not do this if you are using an AV receiver or other external kit with bass
management as this will already be doing this job and probably knows more about your
speakers.

• 

If you're not clear about the choice between the two Bass settings above, select "Bass (LFE Only)"
first and see if your sub produces enough bass. If it doesn't, try the "Bass (Managed)" setting
instead.

3.2.11.5  Audio Output

Use this to select the actual audio output on the Audio Device you selected that should be used to
feed sound to the selected speaker.

Turn the volume down and press one of the "Play" buttons to play a test tone, then bring the level
up a little and try again until it's about right. This can be used to make sure the speakers are all at
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the same level and wired up correctly.

3.2.11.6 Test Play Buttons

There are two play buttons which can be used to send a test tone to a speaker. The ordinary one on
the left sends a test tone directly to a speaker, taking into account the overall and channel levels.

The right hand play button also takes into account how far away the speakers are from the middle of
the room, so more distant speakers play more loudly (which is also what happens during decoding).
This means that you can check all the speaker levels from the centre of the room. This button
becomes unavailable when "Only use location directions" is enabled (see "Distance Mode" above).

3.2.11.7 Volume Modifier

All the speakers should be at roughly the same volume level. Use the "Volume Modifier" to tweak
individual speaker gains if necessary.

3.2.12 What's next?

Once you have set up your layout correctly so that everything looks right, you will probably want to
proceed to the Decoder tab. If you see the following message, this just indicates that you haven't
chosen a decoder method yet, which is typically because you haven't generated one yet. This is all
managed on the Decoder tab.

If you see other errors relating to audio outputs, it isn't necessary to fix them before using the VST
plugins, because the VST plugins do not talk to audio outputs directly. These are managed by your
DAW, which will need separate configuration.
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3.3  The Decoder Tab

This tab is used to determine the mathematical method used to feed audio to the layout set up on
the Layout tab. This mathematical method is known as a "Decoder".

The exact list of items on the "Method" drop-down depends on the particular layout. For instance,
the "Reconstruction" option in the picture above is available for multi speaker arrangements (e.g.
Surround 5.1) but not for Stereo or Headphone Stereo, which have some thoroughly different
options. Whichever option you select, the text below the drop-down describes how this method will
work. Try flipping through the options to see what you're choosing from. Some of these options
make quite noticeable differences to how things will sound.

3.3.1 The "Compute Decoders" Button

If you've just set up a custom layout on the Layout tab, there won't be any methods listed here yet.
This is because preparing the decoders is a complex process and can take a few minutes. We don't
do it until you're sure everything else is set up.

Once you are sure, make sure you don't need your computer for up to half an hour and press the
"Compute Decoders" button to start the process. If there are issues these are typically reported
quickly. Things can go wrong in a number of ways, most typically because the speaker layout isn't
good. You may wish to see our guide to Layout Design.

Decoder generation produces a report that may or may or not be interesting reading for you. Either
way, click "OK" to save all your changes and your new decoders or "Cancel" to go back and make
further changes.

Once decoders have been computed, the button will be disabled. It will re-enable if you change any
of your speaker locations or suchlike on the Layout tab (changing volumes doesn't have this effect).

Note that the decoder generation procedure available here generates decoders of the type
described under "Multi Speaker Methods" below. "Basic" decoders will not be available for some
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layouts where they would perform particularly badly.

3.3.2 The "Import HRTF..." Button

Rapture3D has support for import of custom HRTFs from AES69 files. The button is only enabled
when the layout is set to "Headphone Stereo".

3.3.3 The "Delete HRTF" Button

This can be used to delete custom HRTFs that were imported previously. It is only enabled when
the selected decoder method is a custom HRTF.

3.3.4 Decoder Methods

Since you can flip through the decoder methods anyway, we'll just describe some of the concepts
here so they make a bit more sense. Decoder methods have a variety of pros and cons. Some of
them use more or less CPU power, some of them are more or less sensitive to how accurately
you've set your speakers up and some of them actually will work better for people with differently
shaped heads! The best thing to do is to try some and listen...

3.3.4.1 Headphone Stereo Methods and Binaural

Several of the headphone decoders use HRTFs. HRTFs tell us how sound travels past a human
head and into the ear and provide a great way to provide a realistic sound image over headphones,
often known as Binaural stereo. However, human heads are not all the same shape. We provide six
main "colours" of HRTF - you might like to try these out to find the one that works best for you. At
best HRTFs can place sounds anywhere, including behind and above. However, if they don't really
match your head shape you may find "confusion" occurring, with sounds that should be behind
appearing to be above etc. If you find this happening, try a different HRTF.

HRTF

HRTF-based headphone decoders using psychoacoustic cues to present
sounds in full 3D. Amber is often a good choice.

Emulations of Google's YouTube binaural decoders are included, but please
note that these are first order only.

Custom HRTF Custom HRTF-based headphone decoders using psychoacoustic cues to
present sounds in full 3D. These can be imported from AES69 files.

Simplified HRTF
(Amber)

Version of the Amber HRTF, massively simplified so it is is not
frequency-dependent. This places relatively light load on your CPU.

Panner This splits sounds between the left and right ears using carefully optimised
panning functions. This places relatively light load on your CPU.

The HRTFs provided are based on academic data sets available on the Internet - thanks to all
involved! They've been processed for use with Rapture3D, so any problems are entirely our
responsibility. We've given the data sets colour names like "HRTF (Red)" for simplicity, but you can
see where the HRTF actually came from in the text shown on this tab.

If you don't want to use an HRTF data set you can just select "Panner". This will provide a perfectly
serviceable plain stereo image. You can save a few CPU cycles this way too, although the
Simplified HRTF is no more expensive.

Copyright 2023 Blue Ripple Sound Limited 16



3.3.4.2 Stereo Speaker Methods

If you're just using a normal stereo system then "Panner" is probably what you want here.

Panner This splits sounds between the left and right speakers using carefully optimised
panning functions. This places relatively light load on your CPU.

HCTC Stereo HRTF-based Cross-Talk Cancellation. Requires accurate speaker set up at an
angle of 50 degrees.

HCTC Stereo
(Narrow)

HRTF-based Cross-Talk Cancellation. Requires accurate speaker set up at an
angle of 20 degrees. Amber only.

The HCTC Stereo options can work well if your speakers are set up very accurately and if you don't
move your head much. They're not suited for use with multiple listeners. They're also dependent on
you finding an HRTF data set that works okay for you (the same problems apply as described for
HRTF headphone stereo above). But they're well worth a try, particularly if you're using desktop or
laptop speakers.

But - why only two speakers? To get the best out of Rapture3D you could try using a sound card
that lets you connect more...

3.3.4.3  Multi Speaker Methods

If you're using proper surround sound systems with four or more speakers (e.g. 5.1, 7.1 or 3D7.1) or
a custom layout for which you've computed your own decoders then these options are available:

Basic
This method produces a resilient decoding which should play well on a range of
speaker systems including large venues. It should be used if your speakers are
only roughly in the right places or if your CPU is struggling to keep up.

Reconstruction
This is the default setting. It produces a solid image and uses a sensible amount
of CPU power. It relies on the speaker layout being set up accurately and is
optimised for a domestic or studio listening environment.

Tinted
Reconstruction

This is a more expensive option in CPU terms, but performs HRTF-based tinting
on the audio stream to strengthen the spatial image. For some people, this can
even give a sense of sounds being above and below when all speakers are all
at the same height!

For some preset layouts with a front centre speaker, there are variants of the methods above. This
is because, for compatibility with speaker sets with a special dialogue front centre speaker, the front
centre speaker may be used usually for dialogue only. Note that these methods are not created
when you generate custom decoders. You can decide whether dialogue speakers are used or not in
your decoder by selecting "Front Centre" or "Front Centre (Dialogue Only)" when setting up your
layout.

Basic (Front Pan)
Reconstruction (Front Pan)
Tinted Reconstruction

(Front Pan)

As above, but use the front centre speaker for panning as well as
dialogue. Use this if you are confident that your front centre speaker
has the same response as the others.

For 5.1 and 7.1 preset layouts, a "Pro Logic IIz" method is also available.
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Pro
Logic IIz

This uses phase to encode additional spatial information into 5.1 or 7.1 output which can
be decoded to additional upper-front speakers by compatible receivers. These methods
use the front centre speaker for panning as well as dialogue.

3.3.4.4 Surround Stereo Methods

These are offered if you selected "Surround Stereo" or "Surround Stereo (Compat.)" options on the
Layout tab. Just select the method that matches the surround decoder you are using. If none match,
you probably want to switch your layout back to ordinary Stereo.

Dolby Pro
Logic

This is compatible with Dolby Pro Logic decoders. Your decoder may be able to make
use of a centre speaker and one or two surround speakers at the back of the room.

Dolby Pro
Logic II

This is compatible with Dolby Pro Logic II decoders. Your decoder may be able to
make use of a centre speaker and two surround speakers at the back of the room.

Dolby
Stereo

This is compatible with Dolby Surround decoders. Your decoder may be able to make
use of a centre speaker and one or two surround speakers at the back of the room.

Matrix QS This is compatible with Matrix-QS decoders. These are fairly rare.
Matrix SQ This is compatible with Matrix-SQ decoders. These are fairly rare.

UHJ Stereo This is compatible with ambisonic UHJ Stereo decoders. These are fairly rare. A
"short" version of this is available, with lower latency and quality.

Note that the encoders used here aren't all "official" ones. However, they should be compatible.
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3.4  Importing HRTFs from AES69 Files

3.4.1 Introduction

Head-Related Transfer Functions (HRTFs) are the heart of a technique that allows 3D audio to be
played back on headphones. They work by simulating the acoustic behaviour of the human head
and ears, so the sound fed from the headphones into the ear canal is similar to what would have
arrived there if a real sound had passed around a real human head.

This allows improved 3D imaging on headphones with sounds to the sides, behind, and above and
below. And if you're lucky, in front as well (it seems to be harder to "fool" the brain here, particularly
when the ears contradict the eyes, or sounds do not move as expected when the head moves).

There is a recording technique known as "binaural" recording which produces similar audio, typically
by placing small microphones just in the entry to the ear canal. HRTF processing can be thought of
as "synthetic binaural".

3.4.2 The Personalisation Problem

HRTFs are subtly different for different people, because their heads and ears are not the same size
or shape. Because of this, different HRTFs work more or less well for different people and ideally
we would use one based on an accurate measurement of the acoustics of a person's head.

Rapture3D comes with a number of preset HRTFs which work well for most people. The "Amber"
HRTF is particularly good. But it is possible to do even better using an HRTF tailored for the
individual.

3.4.3 The AES69 File Format

AES69 is a standard file format agreed at the start of 2015, based on the SOFA file format. This
stores HRTF data as Head-Related Impulse Responses (HRIRs) and most such files can be read
by Rapture3D Advanced.

3.4.4 How Do I Get An AES69 File For My Head?

This is probably the most difficult part! We do not do this for you. Once again, we're taking the
"build it and they will come" approach.

A number of people do have accurately measured HRTFs. These have normally been created as
part of research projects and involve elaborate experiments, typically in an anechoic space and
using a large number of speakers. If these measurements are in AES69 form, you should be able to
import them into Rapture3D Advanced.

In addition, significant research is going into the estimation of individual HRTFs, for instance using
photographs or 3D scans of the head. Hopefully, as this technology matures, it should be possible
to write the estimated HRTFs into AES69 files. This is very exciting as it brings personal HRTFs
"into the living room!"

We don't provide these measurement or estimation tools, so we're only providing one piece of the
puzzle here. But hopefully it is a useful one.
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3.4.5 Importing AES69 HRTFs Into Rapture3D Advanced

When Rapture3D Advanced loads an AES69 file, it adds a "Custom HRTF" to the list of available
headphone decoders, which can then be used like the preset HRTFs. To set this up, do the
following:

Go to the Layout Tab and switch the layout to "Headphone Stereo". Check the audio outputs
are directed to actual headphones.

1. 

Then, go to the Decoder Tab and press the "Import HRTF..." button.2. 

This should bring up the "HRTF Import Options" window:

The fields are as follow:

The "Filename" is the name of the AES69 file you want to import. You can type it in, or use
the "Browse" button to find it.

• 

The "Label" is how the HRTF will be labelled in Rapture3D after import. It will show up as a
"Custom HRTF" in the list of decoders available for the "Headphone Surround" layout.

• 

The "Equalization" determines how the overall HRTF frequency response is balanced during
the import process. Generally, you should set this to the type of headphones you are using
("Diffuse Field" or "Free Field"). If this processing has already been applied in the AES69
file, you can leave this option "Off". If in doubt, it is usually best to set this to "Diffuse".

• 

Once your have chosen your settings, press "OK" to start the process. This can take quite some
time, especially the first time it is done for a particular set of directions. Typically this is a few
minutes, but for very large modern data sets (more than a few thousand angles) you may wish to
run the import overnight.

After you have imported your AES69 file, it should appear as a "Custom HRTF" in the list of
decoders available for the "Headphone Surround" layout. You can delete it by selecting it and
pressing the "Delete HRTF" button.
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3.4.6 HRTF Checking

Rapture3D performs a significant amount of processing during import, some of which is quite
sensitive to the quality of the HRIR data in the AES69 file. During processing, it checks some key
features of the HRTF, and if the data looks suspicious it will warn you. If the data looks positively
wrong, it will stop.

Typical reasons for issues include:

Excessive windowing or filtering of data.• 
Inconsistent speaker or microphone levels or placement in recordings.• 
Incorrect coordinates in the AES69 file. (Well, we've not actually seen this yet, but we're
expecting to, because AES69 allows fairly complex geometric transformations.)

• 

Inconsistent polarity when synthesizing data for low frequencies.• 
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3.5  The Rapture3D Games Tab

Here's where gaming settings are selected. You can tune these to make the best use of the
hardware you have available. If in doubt, just press the "Set Defaults" button to choose settings that
make sense. If quality setting are too high, you may find that audio "skips" or other parts of the
game such as the graphics engine struggle to keep up and become jumpy.

3.5.1 Game Gain Adjustment

This gain control is applied in combination with the volume settings on the Layout tab and any
volume controls in the game itself. Note that changes to this volume control are not made until "OK"
or "Apply" are pressed. Assuming you've set the overall volume sensibly, this can usually be left at
0dB - just use volume controls in the game or on external hardware while playing.

3.5.2 Spatialisation Quality

This determines the quality of spatial rendering (3D sound) used by Rapture3D. Note that this
control works on conjunction with the actual decoder method chosen on the Decoder tab.

3.5.3 Resampling Quality

This determines the quality of sample rate conversion used by Rapture3D. This can be particularly
expensive in CPU terms.

3.5.4 Reverb Quality

This determines the quality of the reverb algorithm conversion used by Rapture3D. Note that in
"Low" mode, only one reverb is allowed. Most games only use one reverb (but not all!).
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3.5.5 Default Filter Order

This determines the slope of the filters used by Rapture3D if the game does not specify. Normally
this should be set to "First Order".

3.5.6 Process/Suspend

OpenAL allows context processing to be suspended, which Rapture3D supports by default. It is
sometimes useful to switch this feature off during game development.

3.5.7 Default Sample Rate

When a game that uses OpenAL starts up, it may indicate the sample rate it would like Rapture3D
to use. If it doesn't, this value is used instead. Generally this can be left at 48000Hz, which is
supported natively by a lot of sound cards.

3.5.8 Ignore Game Sample Rate

If this is enabled then the Default Sample Rate above is used regardless of any request from the
game. This can be useful with audio hardware that does not allow more than one sample rate or if
you want to force Rapture3D to run at a lower rate to reduce CPU load.

3.5.9 Masquerade as Standard Driver (Windows Only)

These options allow Rapture3D to "pretend" to be the Generic Software or Generic Hardware
OpenAL drivers. This is quite technical and dangerous and should only be enabled if you're really
sure you know what you're doing.

The reason that using these switches is dangerous is because, to make them useful, you also need
to remove other OpenAL drivers, which have names of form *_oal.dll, from your Windows system
and game directories. These include the real Generic Software and Hardware drivers (typically
provided by wrap_oal.dll). The idea here is that you can remove all other OpenAL drivers from your
system so that Rapture3D (provided by rapture3d_oal.dll) is the only OpenAL driver present. You
can then tell Rapture3D to masquerade as the Generic Software driver so that games will not be
aware that they are using a new driver. This allows Rapture3D to run with quite a few OpenAL
games that predate it and which don't have an option to select which OpenAL driver should be
used.

Bear in mind that some game installers will reinstall the DLLs you deleted so it's worth checking
after an installation to ensure they haven't crept back.

As mentioned before, this approach is quite dangerous. It doesn't work with all OpenAL games
(particularly those that require EAX, which is deprecated and not supported by Rapture3D). You
may break your game installation which would require a reinstall. Also, in principle deleting the
wrong files from Windows system directories can destabilise your entire system, so you might need
to reinstall the whole of Windows, which is something we can't help you with! So be really careful
and only do this sort of thing if you're sure you're comfortable with the risks.

3.5.10 Buffer Configuration

The default buffer length can be set. Bear in mind that this is just a suggestion - actually your audio
card may prefer something different and Rapture3D will go with that. A default buffer length of 256
is generally recommended, though you may find that lengths of 512 or 1024 help if you experience
stuttering or are using a complicated decoder.
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On Windows, an additional buffer count setting can be used. Generally, lower buffer counts lower
latency too, but setting the count too low can introduce stuttering.

If you're wondering what "latency" means, here this is essentially the time delay between initial
audio processing and the sound being sent out of the back of your computer. We work hard to make
this as quick as possible, but in the end latency is generally limited by the quality of your audio
hardware and its driver.

3.5.11 Use Multi-Core Decoder

If you have a multi-core system (likely these days), this can be enabled to allow the decoder to run
on a separate core. This allows more complex decoders to be used, but increases latency slightly.

3.5.12 Release ASIO in Background (Windows Only)

If you have problems using ASIO in more than one piece of Windows software simultaneously, you
may wish to enable this. It causes the Rapture3D OpenAL engine to stop using ASIO while its
output is silent and the software that it is running within is not the foreground application.

3.5.13 Logging Options

These options affect what is written to the Logs tab while gaming:

Enabling the "Verbose" check box causes more detail to be written.• 
Enabling the "Measure Peak Output Level" check box writes lines to the log indicating the
peak level reached. Note that this is the peak level within the software rather than a level
seen in your external audio kit or the actual sound level in the room. Rapture3D drops the
audio level automatically when clipping would occur. If this happens too much then quality
can be reduced.

• 
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3.6  The Ambisonic Playback Tab

Here's where the settings are that are used during ambisonic playback in the Rapture3D Player.
The settings are probably as you want, but you can press the "Set Defaults" button to select ones
that make sense.

3.6.1 Playback Gain Adjustment

This gain control is applied in combination with the volume settings on the Layout tab and the
volume control in the player. It is not a live control and is only read when playback begins.
Assuming you've set the overall volume sensibly, this can usually be left at 0dB - just use the
volume control in the player or on external hardware while actually listening.

3.6.2 Buffer Configuration

The default buffer length can be set. Bear in mind that this is just a suggestion - actually your audio
card may prefer something different and we'll go with that. A default buffer length of 1024 is
generally recommended, though you may find that a length of 2048 or 4096 helps if you experience
stuttering. You may be able to get away with lengths of 512 or even lower, which can reduce
latency.

On Windows, an additional buffer count setting can be used. Generally, lower buffer counts lower
latency too, but setting the count too low can introduce stuttering. If in doubt, just use the defaults.

If you're wondering what "latency" means here, here this is essentially the time delay between initial
audio processing and the sound being sent out of the back of your computer. We work hard to make
this as quick as possible, but in the end latency is generally limited by the quality of your audio
hardware and its driver.

Latency doesn't normally matter much for music playback.
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3.6.3 Use Multi-Core Decoder

If you have a multi-core system (likely these days), this can be enabled to allow the decoder to run
on a separate core. This allows more complex decoders to be used, but increases latency slightly.

3.6.4 Logging Options

These options affect what is written to the Logs tab during ambisonic Playback:

Enabling the "Verbose" check box causes more detail to be written.• 
Enabling the "Measure Peak Output Level" check box writes lines to the log indicating the
peak level reached during playback. Note that this is the peak level within the software
rather than a level seen in your external audio kit or the actual sound level in the room.
Rapture3D drops the audio level automatically when clipping would occur. This is useful but
can reduce playback quality, so it's generally best avoided.

• 
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3.7  The Logs Tab

This tab can be useful for troubleshooting. It shows recent events concerning Rapture3D and
related Blue Ripple Sound software. The first thing to point out is that lines appear in reverse time
order, so the latest message is at the top.

Log entries come from a variety of sources and depend on what you've been doing. Note that
Rapture3D is started up twice by many games, once to check its features and once to actually use
it.

The "Clear Logs" button clears the logs immediately.
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3.8  The Licenses Tab

This tab should list the licenses you have. Licenses can be added using the "Add" button, assuming
you have an Internet connection. The license comes in the form of a hyphenated string of
characters where the "XXXX-XXXX-XXXX-XXXX" is in the example above.

Licenses are available from Blue Ripple Sound.

3.8.1 How Licenses Work

Once a day, when you use Rapture3D or a similarly licensed piece of Blue Ripple Sound software,
the software "phones home" across the Internet to refresh the license. No personal information is
transmitted and encryption is used. This tab will tell you if your licenses are fresh. If they aren't, the
text here will change and eventually the software will stop working, typically a month after the last
successful refresh. Some licenses (typically trial or beta testing licenses) expire automatically and
permanently, so you'll need to get another one to keep using the software.

3.8.2 Hardware Changes

The license is stored with a short description of your machine. This means that if your machine
changes, for instance if you upgrade the CPU or switch the network card, your machine may seem
to be different and license checks may fail. The best thing to do if you're upgrading some hardware
is to revoke the license before making the change and to add it back again afterwards.

If you run into trouble, please get in touch with Blue Ripple Sound from the email address you used
when buying the software and hopefully we can sort things out.
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3.8.3 Revoking Licenses

Licenses can only be used on one machine, so if you want to move your license from one machine
to another you need to revoke it. This is done with the "Revoke" button. You'll also be asked if you
want to do this if you uninstall Rapture3D. Note that this requires an Internet connection.

If you revoke your license write it down somewhere if you haven't kept your original documentation,
so you have it to hand when you want to install Rapture3D somewhere else!
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4 The Rapture3D Decoder Studio Plugins
This version of Rapture3D ships with AAX and VST2 decoder plugins for use within studio Digital
Audio Workstations (DAWs), in particular Reaper and Pro Tools (Ultimate or Studio).

The plugins use the current layout settings made in the Rapture3D GUI's layout tab, except for the
hardware connections, which are ignored. These need to be set separately in your DAW.

The plugins are intended particularly for work with Third Order Ambisonic (O3A) streams, although
they can also be used with lower order streams, using SN3D or FuMa encoding. There are various
other O3A plugins libraries available from Blue Ripple Sound.

4.1 Setup

You may need to activate your plugins before use, using the Blue Ripple Sound License Manager,
which normally can be found in a Blue Ripple Sound folder on the Start menu (on Windows) or in
your Applications folder (on macOS).

4.2 Compatibility

These plugins expect busses with at least 16 channels, which (at the time of writing) most Digital
Audio Workstations (DAWs) cannot handle. Some are limited at 2 channel stereo and many are
limited at the 8 channels used for 7.1 surround mixes. These plugins will not work correctly with
these DAWs, which may even crash. You may wish to try Pro Tools (Ultimate or Studio) or Reaper.

4.2.1 AAX

Rapture3D Advanced decoding can also be used with Pro Tools Ultimate or Studio. Pro Tools
keeps careful track of exactly what stem formats are present on tracks and busses; this is a
powerful feature which helps avoid mistakes and ensure plugins are used in the right places.
However, Rapture3D Advanced uses arbitrary output formats, which Pro Tools may or may not
know about.

To handle this, the AAX plugins "misuse" their output stem formats by setting them to 7.1 or third
order ambisonics, regardless of the actual output format in use in Rapture3D. This is simply to
access the right number of output channels (8 or 16 respectively). A number of block decoders can
be used together to provide support for higher output channel counts. This is described in more
detail below.

4.2.2 VST2

The plugin library works as a VST2 "shell" plugin. This means that a number of individual audio
plugin effects are provided by a single library file. Your VST host may have a slightly different way of
managing these plugins to ordinary ones. For instance, in Max/MSP the vst~ plugin uses library
filenames and "subname" messages to specify the individual plugin within the library.

Four versions of the main decoder plugin are provided, differing only in their output channel count
(16, 32, 64 or 128). Pick the smallest one with enough channels for your speaker rig. The plugins
have names like "O3A Decoder - Rapture3D Advanced (16 Channels)".

In addition, a "block" decoder provides eight selectable channels of output. In some DAWs (such as
Reaper), a number of these can be used in parallel to allow decoding for large numbers of channels
on multicore CPUs. For instance, for a 24 channel decode, the first block decoder might output
channels 1-8 on one track, the second channels 9-16 and so on. In addition, the order can be
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lowered to reduce load. This plugin is named "O3A Decoder Block - Rapture3D Advanced".

Most DAWs have a VST plugin "path", which is a list of directories which will be searched for VST2
plugins. You may need to change this path to point at the location of the plugins, or move the
plugins there. By default, these plugins are installed into /Library/Audio/Plug-Ins/VST on
macOS. Various directories may be used on Windows, but C:\Program
Files\Steinberg\VST2 is not uncommon.

4.2.3 Buffering

In most modes, these plugins use internal buffering with a length of 128 samples. For smooth CPU
load, you may need to ensure your DAW buffer size is a multiple of this.
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4.3 O3A Decoder (16, 32, 64 and 128 Channels) - Rapture3D
Advanced

4.3.1 Host Support

4.3.1.1 O3A Decoder (16 Channels) - Rapture3D Advanced

Host Type Support
AAX Yes, output mapped to third order ambisonics
VST2 Yes

4.3.1.2 O3A Decoder (32 Channels) - Rapture3D Advanced

Host Type Support
AAX No
VST2 Yes

4.3.1.3 O3A Decoder (64 Channels) - Rapture3D Advanced

Host Type Support
AAX Yes, output mapped to seventh order ambisonics
VST2 Yes

4.3.1.4 O3A Decoder (128 Channels) - Rapture3D Advanced

Host Type Support
AAX No
VST2 Extreme channel count excludes most hosts

4.3.2 Audio

4.3.2.1 O3A Decoder (16 Channels) - Rapture3D Advanced

Channels Content
Input 16 O3A
Output 16 Configurable (mapped to third order ambisonics for AAX)
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4.3.2.2 O3A Decoder (32 Channels) - Rapture3D Advanced

Channels Content
Input 16 O3A
Output 32 Configurable

4.3.2.3 O3A Decoder (64 Channels) - Rapture3D Advanced

Channels Content
Input 16 O3A
Output 64 Configurable (mapped to seventh order ambisonics for AAX)

4.3.2.4 O3A Decoder (128 Channels) - Rapture3D Advanced

Channels Content
Input 16 O3A
Output 128 Configurable

4.3.3 Controls

Order• 
Reload• 
Format• 

4.3.4 Description

This plugin is not self-contained. It uses the decoder currently selected within the separate
Rapture3D Advanced layout manager application, which must also be installed and set up. This
decoder is intended for monitoring or playback in studios and concert venues where a specific and
measured speaker layout is in use.

The channel routing ("Audio Device", "Audio Output" and so on) set up in the Rapture3D layout tab
is not used, but the channel gains are. The channels appear in the same order as shown there. You
can change this order using Reaper's routing matrices, or in the layout tab (which is normally
better). If you want to create silent output channels for unused outputs this can be achieved by
adding a channel with an "Inactive" speaker role.

When many channels are used this plugin can produce high CPU loads, which may result in
stuttering if decoding is attempted in real time. In some DAWs (e.g. Reaper) the CPU load can be
distributed better by tuning buffer sizes, and instead using the 'block' decoder plugin.

The AAX version of the IMAX 12.0 plugin requires Pro Tools 2023.6 or later.

Only the 16 and 64 channel versions of this plugin are available in AAX. The 'block' decoder can be
used to achieve other channel counts. Please note that the output of this plugin is not an ambisonic
feed; the third order ambisonic stem format is only used to create a 16 or 64 channel output.
Channel outputs appear in the order set up in the Rapture3D configuration screen.

4.3.4.1 Mastering - A Word of Caution

Rapture3D Advanced allows you to calibrate for your speaker array precisely and can give fantastic
results. However, if you are using it to produce a decoded surround sound master for distribution
(e.g. 5.1) then it is important to remember that your audience will probably not be using exactly the
same speaker setup as you. Rapture3D may have applied subtle equalization and other processing
to make the decode work well for you, but which may make it sound worse on another system.
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Because of this, when mastering for distribution you should normally make sure you use "standard"
speaker layout angles, and no distance information. Our presets should be a good start point here.
Further, the "Basic" decoder method is usually the best choice as this is the least affected by bad
speaker placement.

We recommend the use of this plugin while monitoring, for the best experience of the mix while
working on it. However, at the actual point of finalising a surround master it is important not to use
any calibration which was specific to the mastering room. A simple way to do this (without the
hassle of reconfiguring this plugin) is to use the standard preset decoders from the Blue Ripple
Sound O3A Decoding plugin library.

4.3.5 Controls

4.3.5.1  Control: Order

Normally this should be set to three for work with Third Order Ambisonic (O3A) streams. For lower
order streams, for instance from a first order (four channel) B-Format microphone, the order should
be set to match the stream. Dropping the order to match the stream exactly can give a slightly better
decode and uses less CPU.

4.3.5.2  Control: Reload

This button reads the currently active Rapture3D settings into the plugin. To reconfigure this plugin,
change the settings in the Rapture3D speaker layout application, press "Apply" or "OK" and then
press the "Reload" button on the plugin. Active Rapture3D settings are also reloaded when the
plugin is started. Settings are not otherwise kept between sessions.

4.3.5.3  Control: Format

The input format describes the first order ambisonics that is being fed into this plugin. Setting this
incorrectly will give bad results. The options are:

"SN3D" (in the ACN channel ordering) is the format used by the O1A and O3A plugins. It is
used by some recent first order microphones and is sometimes known as "AmbiX".

• 

First order "FuMa" is the same as classic WXYZ B-Format, which dates back to the 1970's.
It was used in versions of these plugins prior to version 2.0 and some hardware and
software uses it, including a number of 3D microphones.

• 
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4.4 O3A Decoder Block (8 Channels) - Rapture3D Advanced

4.4.1 Host Support

Host Type Support
AAX Yes, output mapped to 7.1
VST2 Yes

4.4.2 Audio

Channels Content
Input 16 O3A
Output 8 Configurable (mapped to 7.1 for AAX)

4.4.3 Controls

Order• 
Block Range• 
Reload• 
Format• 

4.4.4 Description

This plugin is very similar to the O3A Decoder - Rapture3D Advanced plugins. It is intended for use
with decodes with many channels, from which it manages a block of just eight. For instance, the
plugin might be configured to output channels 1-8, or 9-16, and so on.

This allows a number of copies of the plugin to be set up in parallel to produce all the channels
needed for a particular decode.

Arranging for the decode to happen in this way allows some DAWs to distribute the decoder CPU
load over a number of CPU cores, which make it possible to perform huge decodes in real time.
Typically, one instance of this plugin is used per track.

The AAX versions of these plugins label their eight-channel output as 7.1 for compatibility with Pro
Tools' stem format management, regardless of the actual format in use. Channel outputs appear in
the order set up in the Rapture3D configuration screen. If you actually want to decode to 7.1, please
note that the channel ordering for 7.1 in Pro Tools is not the same as in the standard Rapture3D
preset. If this is inconvenient, customise the 7.1 decoder layout and reorder the channels. You may
also wish to switch the "Front Centre (Dialogue Only)" channel's Speaker Role to "Front Centre" as
otherwise the front centre will be silent in normal use.
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4.4.5 Controls

4.4.5.1  Control: Order

Normally this should be set to three for work with Third Order Ambisonic (O3A) streams. For lower
order streams, for instance from a first order (four channel) B-Format microphone, the order should
be set to match the stream. Dropping the order to match the stream exactly can give a slightly better
decode and uses less CPU.

4.4.5.2  Control: Block Range

Block range controls which output channels from the decoder are produced by this plugin. It has
values such as "1-8", "9-16" and so on.

4.4.5.3  Control: Reload

This button reads the currently active Rapture3D settings into the plugin. To reconfigure this plugin,
change the settings in the Rapture3D speaker layout application, press "Apply" or "OK" and then
press the "Reload" button on the plugin. Active Rapture3D settings are also reloaded when the
plugin is started. Settings are not otherwise kept between sessions.

4.4.5.4  Control: Format

The input format describes the first order ambisonics that is being fed into this plugin. Setting this
incorrectly will give bad results. The options are:

"SN3D" (in the ACN channel ordering) is the format used by the O1A and O3A plugins. It is
used by some recent first order microphones and is sometimes known as "AmbiX".

• 

First order "FuMa" is the same as classic WXYZ B-Format, which dates back to the 1970's.
It was used in versions of these plugins prior to version 2.0 and some hardware and
software uses it, including a number of 3D microphones.

• 

Copyright 2023 Blue Ripple Sound Limited 36



4.5 O7A Decoder (16, 32, 64 and 128 Channels) - Rapture3D
Advanced

4.5.1 Host Support

4.5.1.1 O7A Decoder (16 Channels) - Rapture3D Advanced

Host Type Support
AAX Yes, output mapped to third order ambisonics
VST2 Yes

4.5.1.2 O7A Decoder (32 Channels) - Rapture3D Advanced

Host Type Support
AAX No
VST2 Yes

4.5.1.3 O7A Decoder (64 Channels) - Rapture3D Advanced

Host Type Support
AAX Yes, output mapped to seventh order ambisonics
VST2 Yes

4.5.1.4 O7A Decoder (128 Channels) - Rapture3D Advanced

Host Type Support
AAX No
VST2 Extreme channel count excludes most hosts

4.5.2 Audio

4.5.2.1 O7A Decoder (16 Channels) - Rapture3D Advanced

Channels Content
Input 64 O7A
Output 16 Configurable (mapped to third order ambisonics for AAX)
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4.5.2.2 O7A Decoder (32 Channels) - Rapture3D Advanced

Channels Content
Input 64 O7A
Output 32 Configurable

4.5.2.3 O7A Decoder (64 Channels) - Rapture3D Advanced

Channels Content
Input 64 O7A
Output 64 Configurable (mapped to seventh order ambisonics for AAX)

4.5.2.4 O7A Decoder (128 Channels) - Rapture3D Advanced

Channels Content
Input 64 O7A
Output 128 Configurable

4.5.3 Controls

Order• 
Reload• 
Format• 

4.5.4 Description

This plugin is not self-contained. It uses the decoder currently selected within the separate
Rapture3D Advanced layout manager application, which must also be installed and set up. This
decoder is intended for monitoring or playback in studios and concert venues where a specific and
measured speaker layout is in use.

The channel routing ("Audio Device", "Audio Output" and so on) set up in the Rapture3D layout tab
is not used, but the channel gains are. The channels appear in the same order as shown there. You
can change this order using Reaper's routing matrices, or in the layout tab (which is normally
better). If you want to create silent output channels for unused outputs this can be achieved by
adding a channel with an "Inactive" speaker role.

When many channels are used this plugin can produce high CPU loads, which may result in
stuttering if decoding is attempted in real time. In some DAWs (e.g. Reaper) the CPU load can be
distributed better by tuning buffer sizes, and instead using the 'block' decoder plugin.

Only the 16 and 64 channel versions of this plugin are available in AAX, and the 64 channel version
requires Pro Tools Ultimate 2023.6 or later. The 'block' decoder can be used to achieve other
channel counts. Please note that the output of this plugin is not an ambisonic feed; the third order
ambisonic stem format is only used to create a 16 or 64 channel output. Channel outputs appear in
the order set up in the Rapture3D configuration screen.

4.5.4.1 Mastering - A Word of Caution

Rapture3D Advanced allows you to calibrate for your speaker array precisely and can give fantastic
results. However, if you are using it to produce a decoded surround sound master for distribution
(e.g. 5.1) then it is important to remember that your audience will probably not be using exactly the
same speaker setup as you. Rapture3D may have applied subtle equalization and other processing
to make the decode work well for you, but which may make it sound worse on another system.
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Because of this, when mastering for distribution you should normally make sure you use "standard"
speaker layout angles, and no distance information. Our presets should be a good start point here.
Further, the "Basic" decoder method is usually the best choice as this is the least affected by bad
speaker placement.

We recommend the use of this plugin while monitoring, for the best experience of the mix while
working on it. However, at the actual point of finalising a surround master it is important not to use
any calibration which was specific to the mastering room. A simple way to do this (without the
hassle of reconfiguring this plugin) is to use the standard preset decoders from the Blue Ripple
Sound O7A Decoding plugin library.

4.5.5 Controls

4.5.5.1  Control: Order

Normally this should be set to seven for work with Seventh Order Ambisonic (O7A) streams. For
lower order streams, for instance from a first order (four channel) B-Format microphone, the order
should be set to match the stream. Dropping the order to match the stream exactly can give a
slightly better decode and uses less CPU.

Older preset HRTF decoders are limited at fifth order. When a lower order decode is used than
requested, this is indicated by displaying the actual order in square brackets. This does not affect
Amber or Purple.

4.5.5.2  Control: Reload

This button reads the currently active Rapture3D settings into the plugin. To reconfigure this plugin,
change the settings in the Rapture3D speaker layout application, press "Apply" or "OK" and then
press the "Reload" button on the plugin. Active Rapture3D settings are also reloaded when the
plugin is started. Settings are not otherwise kept between sessions.

4.5.5.3  Control: Format

The input format describes the first order ambisonics that is being fed into this plugin. Setting this
incorrectly will give bad results. The options are:

"SN3D" (in the ACN channel ordering) is the format used by the O1A, O3A and O7A plugins.
It is used by some recent first order microphones and is sometimes known as "AmbiX".

• 

First order "FuMa" is the same as classic WXYZ B-Format, which dates back to the 1970's.
It was used in versions of these plugins prior to version 2.0 and some hardware and
software uses it, including a number of 3D microphones. FuMa is only defined up to third
order.

• 
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4.6 O7A Decoder Block (4 and 8 Channels) - Rapture3D
Advanced

4.6.1 Host Support

4.6.1.1 O7A Decoder Block (4 Channels) - Rapture3D Advanced

Host Type Support
AAX Yes, output mapped to quad
VST2 Yes

4.6.1.2 O7A Decoder Block (8 Channels) - Rapture3D Advanced

Host Type Support
AAX Yes, output mapped to 7.1
VST2 Yes

4.6.2 Audio

4.6.2.1 O7A Decoder Block (4 Channels) - Rapture3D Advanced

Channels Content
Input 64 O7A
Output 4 Configurable (mapped to quad for AAX)

4.6.2.2 O7A Decoder Block (8 Channels) - Rapture3D Advanced

Channels Content
Input 64 O7A
Output 8 Configurable (mapped to 7.1 for AAX)

4.6.3 Controls

Order• 
Block Range• 
Reload• 
Format• 

4.6.4 Description

These plugins are very similar to the O7A Decoder - Rapture3D Advanced plugins. They intended
for use with decodes with many channels, from which the manage a block of just four or eight. For
instance, the plugin might be configured to output channels 1-4 or 5-8, or 1-8 or 9-16, and so on.
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This allows a number of copies of the plugin to be set up in parallel to produce all the channels
needed for a particular decode.

Arranging for the decode to happen in this way allows some DAWs to distribute the decoder CPU
load over a number of CPU cores, which make it possible to perform huge decodes in real time.
Typically, one instance of this plugin is used per track.

4.6.5 Controls

4.6.5.1  Control: Order

Normally this should be set to seven for work with Seventh Order Ambisonic (O7A) streams. For
lower order streams, for instance from a first order (four channel) B-Format microphone, the order
should be set to match the stream. Dropping the order to match the stream exactly can give a
slightly better decode and uses less CPU.

Older preset HRTF decoders are limited at fifth order. When a lower order decode is used than
requested, this is indicated by displaying the actual order in square brackets. This does not affect
Amber or Purple.

4.6.5.2  Control: Block Range

Block range controls which output channels from the decoder are produced by this plugin. The four
channel version of this plugin has values like "1-4" or "5-8" or so on, and the eight channel version
"1-8", "9-16" etc.

4.6.5.3  Control: Reload

This button reads the currently active Rapture3D settings into the plugin. To reconfigure this plugin,
change the settings in the Rapture3D speaker layout application, press "Apply" or "OK" and then
press the "Reload" button on the plugin. Active Rapture3D settings are also reloaded when the
plugin is started. Settings are not otherwise kept between sessions.

4.6.5.4  Control: Format

The input format describes the first order ambisonics that is being fed into this plugin. Setting this
incorrectly will give bad results. The options are:

"SN3D" (in the ACN channel ordering) is the format used by the O1A, O3A and O7A plugins.
It is used by some recent first order microphones and is sometimes known as "AmbiX".

• 

First order "FuMa" is the same as classic WXYZ B-Format, which dates back to the 1970's.
It was used in versions of these plugins prior to version 2.0 and some hardware and
software uses it, including a number of 3D microphones. FuMa is only defined up to third
order.

• 
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5 The Rapture3D OpenAL Driver
OpenAL allows games to make use of special OpenAL "drivers" which provide 3D audio algorithms.
These algorithms may be provided in software or hardware.

Rapture3D includes a software OpenAL driver with some particularly interesting algorithms.
Amongst other things, it uses Higher Order Ambisonics for superior 3D audio spatialisation.

5.1 Using The Driver On Windows

On Windows, the driver is a special file called rapture3d_oal.dll.

5.2 Using The Driver On macOS

On macOS, the Rapture3D driver is a special file called libOpenAL.Rapture3D.dylib. It is
configured with the Games tab in the layout program.

Unlike Windows, macOS does not have an OpenAL "router" driver to allow software to switch
between alternative OpenAL implementations, so it is tricky to change the OpenAL driver away from
the default Apple implementation without doing bad things to your system. Be careful!

5.3 Configuration

Ideally, the game will have been written to use this driver. When it hasn't, it may still be possible to
make it work by switching to it using the game's configuration screens or by replacing the system's
default OpenAL driver. However, this involves modification to system files so we cannot recommend
this for ordinary users. If you do go ahead, ensure you keep a copy of the original driver so you can
return your system to its original configuration.

The driver can be configured with the "Games" tab.
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6 Rapture3D Ambisonic Player

This edition of Rapture3D comes with an ambisonic sound file player. It uses the same layout and
decoding configuration as the Rapture3D OpenAL game engine. It has its own tab for fine tuning.
You'll need an "Ambisonic Playback" license, which should be listed on the Licenses tab.

If you do have ambisonic sound files around in .AMB format then well done! Hopefully you can just
double-click on them and they'll play in full 3D. The player can also handle ambisonic audio
contained in a range of other file formats, including simple Ogg/Vorbis files (.OGG or .OGA), though
you'll probably want to open these directly from the application. In these cases, channel counts are
used to infer the ambisonic order. It can't always guess whether the audio is FuMa or SN3D, so you
might need to set that in the Formats menu.

6.1 Playlists

The left pane shows the list of files that the player is working with at the moment. You can add files
with the "Open..." or "Add..." options on the File menu, or by dragging and dropping from Windows
Explorer or macOS Finder. Once files are in the list you can drag them to change their place in the
play order and double-click to play.

Playlists can be loaded and saved as simple text files using the "Playlist" menu.

6.2 Formats

The player can handle audio using either the FuMa convention (which is backwards-compatible with
"classic" ambisonics) or SN3D (ACN) convention.

When a multichannel audio file is read, the player can sometimes identify whether FuMa or SN3D is
in use automatically. Specifically, .AMB files always use FuMa. To handle other cases, the Format
menu can be used to control how files will be interpreted.

Depending on the decoder, up to third order FuMa is supported and up to seventh order SN3D,
although you may need a very powerful machine for multichannel speaker layouts or higher
visualisation settings.
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6.3 Controls

The bar below the playlist can be used to jump to particular locations in the audio that is currently
selected.

Below that you'll find standard player controls. These are:

Skip to previous track• 
Play/pause• 
Stop• 
Skip to next track• 
Volume• 

6.4 Status Bar

At the very bottom of the window is the status bar. This will tell you the details of the current audio
that is playing and anything else you might need to know if there's a problem.

6.5 Visualisation

On the right hand of the player is a visualisation area. This will light up in different areas, depending
on where sounds are coming from.

In case you're interested, the visualisation is actually based on the 3D information in the stream,
using a projection similar to that used in maps of the world. Sounds playing above appear at the top
in the image, sounds below appear at the bottom, sounds at the front appear in the middle, sounds
to the left of that appear to the left of centre and so on. Sounds visualised on the left and right edges
of the image are behind (the image "wraps around" at the back, again as in a map of the world).
Note that typical real recordings produce extremely complex visualisations due to acoustic
reflections.

The "View" menu gives some options to control the visualisation, including control of the quality
used. Higher quality settings put more load on your CPU.

6.6 Command-Line (Windows Only)

For those of you that use the command-line, it's worth noting that on Windows (not macOS),
Rapture3D supports some command-line options, including a full-screen mode. This has reduced
functionality, but is designed for concerts or installations. Run "Rapture3dPlayer.exe -h" to list the
command-line options.
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7 Technical Notes

7.1 3D7.1

3D7.1 is a variant of the 7.1 surround speaker arrangement. The original 7.1 surround speaker
arrangement typically places three speakers at the front of the room, two at the sides and two at the
back. Further, a subwoofer (the ".1" in the name) is placed somewhere in the room (it doesn't matter
too much where). Quite a few computers come with 7.1 surround sound these days and there are
packages for sale that allow it to be added if not. The arrangement of the main seven speakers here
puts all speakers at the same height, which is a bit of a shame when using games where things are
happening above and below!

The 3D7.1 speaker arrangement (invented by Simon N. Goodwin) is designed so that usually it can
be used with existing 7.1 sound hardware. All you have to do is change where you put your
speakers. It's also designed so that stereo material or 5.1 material will still play back well. The
advantage is that games or other 3D audio software that can handle this speaker arrangement (e.g.
via Rapture3D) can produce sound in proper full 3D!

7.1.1 Speaker Locations

Speakers should be placed as follows:

Original 7.1 Speaker Location 3D7.1 Speaker Location
Front Left Upper Front Left
Front Right Upper Front Right
Front Centre Front Centre
Subwoofer Subwoofer
Back Left Upper Back Centre
Back Right Lower Front Centre
Side Left Lower Back Left
Side Right Lower Back Right

More mathematically, six of the speakers (ignoring the front centre and subwoofer) should form a
regular octahedron aligned so front and back faces are vertical.

7.1.2 Configuration

Once you have your speakers set up correctly, select "Surround 3D7.1" in the Layout tab and check
the speakers are wired up correctly. You'll probably want to use the test tones to check the
speakers are in the right order after all that work!

After this you can select a Decoder as usual.
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7.2 Basic Speaker Layout Design

Speaker Layout design is as much an art as a science and there's a lot to it, so we're not going to
go into huge detail here - instead, we're just providing a list of points to consider when setting up a
custom speaker layout. Rapture3D will cope with most sensible speaker layouts that you are likely
to throw at it.

7.2.1 Basics

First, some basic advice:

Decide where you want to put your speakers and how you're going to wire everything up before you
start - and write it down. It'll save time later.

Secure raised speakers carefully. You'll forget they're there and they have further to fall.

Be really careful with wires, particularly if you're using raised speakers. Tripping over a cable
attached to a speaker several metres in the air can be extremely dangerous - and expensive.

Be really careful about volume levels when setting up - and test everything, particularly before
starting a game. It's also good practice to be set up so you know where your emergency "power off"
button is in case you get volume settings wrong later.

Talk to your partner/kids/pets/etc. before setting up a really complex rig, particularly if it's going in
the living room.

7.2.2 Room Preparation

Try to ensure there are no obstructions between the origin (where the listener's head should be) and
the speakers.

Try to avoid reflective (hard) surfaces within or around the speaker array.

Again, please be really careful about cables and raised speakers.

7.2.3 Coverage

Rapture3D differentiates between "horizontal" (2D) and "periphonic" (3D) speaker layouts.
Horizontal ones are all at the same height (all Z settings should be zero) and periphonic ones may
have speakers placed anywhere in 3D space. Decide which you're going for before you start and
then think about "coverage" accordingly.

"Coverage" is the largest gap between speakers (measured as an angle). Where there are large
gaps, the quality of spatialisation is reduced. Ideally, make speakers equally spaced, either
horizontally or periphonically, so that all the gaps are similar in size. Or at least avoid big gaps
where possible (although some are inevitable, typically below). The decoder generation report will
tell you the actual coverage angle you've ended up with.

Rapture3D will cope with some fairly silly speaker rigs, but you'll typically be missing spatial detail
where speakers are missing.
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7.2.4 Distance

Try to put all your speakers at roughly the same distance from the origin. Rapture3D will attempt to
compensate for different distances (unless "Only use location directions" is selected) but this
behaviour can be non-optimal, particularly in reflective rooms.

Note that Rapture3D assumes a reference speaker distance of 1m, and more distant speakers will
typically be driven louder (see the Distance Mode section).

7.2.5 Configuring Rapture3D

Please either give the real speaker locations to Rapture3D or enable the "Only use location
directions" switch. Rapture3D does some quite clever stuff with distance information if it's there, but
if it isn't right then things can sound very wrong.

When configuring levels, a good method is to check all speakers produce the same output when
measured 1m in front of them, for instance by use of an SPL meter attached to a piece of bamboo
1m long (but be careful not to damage your speakers!). The left "test" button will produce a test
signal taking into account the overall and channel levels set, so after configuration this button
should produce the same level for all speakers when measured this way. A cruder method is to
check all speakers produce the same level at the centre of the room using the right test button (or
the left button when "Only use location directions" is enabled). This typically does not produce such
good results, but can be useful when time is short, access is difficult, or there is significant occlusion
between the listening area and speakers.

The tinted reconstruction decoders are generated on the assumption that the audience is facing
forwards (positive X). Therefore, please ensure that the locations given take this into account. If the
audience isn't facing this way (e.g. because the audience may actually be wandering around in the
listening space), we don't advise the use of front-facing tinted decoders. Instead, set "Audience
Face" to "Upright" or "Free", or use a "Reconstruction" decoder.

7.2.6 Use Your Ears

Things don't always work well, typically because the room acoustic isn't as well behaved as one
might like, or because the speakers are not set out well. If this happens, think about where the
spatialisation isn't clear, because you might like to try moving your speakers so your coverage is
better in that area. But don't forget to regenerate the decoder.

Try different things out - and have fun!
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7.3 OpenAL Developer Notes

Here are some technical notes for developers who might be interested in tuning their games to get
the best out of Rapture3D.

The Rapture3D OpenAL driver is built in software and so consists primarily of a driver dynamic
library and a configuration tool. It comes in a number of editions with different licensing schemes
and features. The "Game" edition is restricted to work only with the games it ships with.

7.3.1 OpenAL Specification

Rapture3D meets the full OpenAL 1.1 specification, including full support for alSuspendContext()
and alProcessContext() to give much better control over scene content than many drivers.

All filters support high-pass as well as low-pass options as documented in the specification.

7.3.2 Ambisonics

Rapture3D's heart is a studio-grade 3D rendering core based on Higher Order Ambisonics. This
allows great flexibility when the audio is "decoded" for an actual speaker arrangement, or
headphones.

7.3.3 OpenAL Extensions

Rapture3D supports the following OpenAL extensions:

ALC_ENUMERATE_ALL_EXT• 
ALC_ENUMERATION_EXT• 
ALC_EXT_CAPTURE• 
ALC_EXT_DEDICATED• 
ALC_EXT_EFX• 
ALC_EXT_STATIC_BUFFER• 
AL_EXT_BFORMAT• 
AL_EXT_EXPONENT_DISTANCE• 
AL_EXT_FLOAT32• 
AL_EXT_FOLDBACK• 
AL_EXT_IMA4• 
AL_EXT_LINEAR_DISTANCE• 
AL_EXT_MCFORMATS• 
AL_EXT_MULAW• 
AL_EXT_MULAW_BFORMAT• 
AL_EXT_MULAW_MCFORMATS• 
AL_EXT_OFFSET• 
AL_EXT_STEREO_ANGLES• 
AL_EXT_SOURCE_RADIUS• 

ALC_EXT_CAPTURE is only supported in the sense that the extension is present as required by
the OpenAL specification. No capture device is provided.

ALC_EXT_DEDICATED allows sounds to be sent directly to a dialogue speaker or subwoofer if one
is present.

ALC_EXT_FOLDBACK is a new extension that allows the game to capture mono or stereo
downmixes of the game output, e.g. for movie clip recording.
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AL_EXT_BFORMAT allows ambisonic B-Format material (WXYZ or WXY) to be used directly as
game audio assets. Such material can contain a complete pre-rendered "soundscape" that can
rotate with the orientation of the listener.

AL_EXT_STEREO_ANGLES allows stereo assets to be panned horizontally.

AL_EXT_SOURCE_RADIUS allows mono sources to change size.

7.3.4 Scalability and CPU Load

Rapture3D has configuration options to scale CPU load to meet the hardware available. Default
settings choose sensible options if the user does not select them explicitly. The code has been
tuned heavily for CPU load.

Rapture3D does not place any limits on how many sources, buffers, filters, effects or aux sends are
used. The only limit is the CPU power available on the machine used.

7.3.5 Audio Quality

All internal processing is performed using 32bit floating point operations. Sample rate conversion
options include linear and sinc interpolation. A lot of attention has gone into ensuring that control
changes result in smooth audio flow.

7.3.6 Effects

Rapture3D supports the EFX interface for effects. The deprecated EAX interfaces are not
supported. The following effects are available:

AL_EFFECT_CHORUS• 
AL_EFFECT_COMPRESSOR• 
AL_EFFECT_DEDICATED_DIALOGUE• 
AL_EFFECT_DEDICATED_LOW_FREQUENCY_EFFECT• 
AL_EFFECT_DISTORTION• 
AL_EFFECT_EAXREVERB• 
AL_EFFECT_ECHO• 
AL_EFFECT_EQUALIZER• 
AL_EFFECT_FLANGER• 
AL_EFFECT_REVERB• 
AL_EFFECT_RING_MODULATOR• 

Note that the same reverb algorithm is used for AL_EFFECT_REVERB and
AL_EFFECT_EAXREVERB although different parameters are exposed. All the available
parameters are used, including the directional reverb controls. The algorithm is an optimised
high-quality ambisonic reverb, producing B-Format output directly.
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